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HiL-Setup with PSI5, SPI and SQUIB

1. Overview Seskion HiL-Setup

1.1 Seskion HiL Explanation

To generate a complete HIL simulation for an airbag control unit, the internal acceleration sensor signals of the control unit
(SPI) and the peripheral acceleration and pressure sensor signals (PSI5) must be connected. Furthermore, a PC system
connected to the simulators via a USB port/network is used for data processing.

Often up to 6 or more PSI5-Simulyzer are operated together with several SPI-Simulyzer. For coordination there is a
superordinate configuration, which determines which Simulyzer is used, which signal traces are used by which Simulyzer
and which detailed configurations are to be used with the bus parameters. By using the superordinate configuration, the
operation of the API is very simple.

A continuous control of the sensor signals can also be made.

1.2 Possible HiL-Setup

Below you can see a HilL-Setup which is already implemented and in use at several OEMs:
Seskion Units

PSI5 Bus
XCh

=

i
Pepl. Loops
I _XCh

1.3 FAQ

Question: | need to simulate synchronized PSI5 data on all my Test ECU's channels. Is there a way to synchronize multiple
Simulyzers so that they start transmission at the same time?

Answer: All Simulyzer's have digital inputs/outputs which either generate or receive a trigger signal. On reception of this
trigger signal simulation data is streamed on the PSI5 interfaces.

Question: | will have sensor data from a real-world source which | will need to "replay" in simulation with the Simulyzer
tool. Is this possible?

Answer: This data is already queued via USB to the boxes, so there is no delay in between trigger signal and data stream
start. The stream data could be imported from .cvs files or provided as binary data on the API interface.

Question: Multiple Simulyzers will need to be linked together in parallel to achieve simulation on all my Test ECU's
channels. How many can | link together?

Answer: There is no limitation of parallel used Simulyzer's on the PC. We recommend dedicated USB host controller cards
in the PC instead of USB connection on motherboards when using multiple Simulyzer's in parallel.

Question: | need to control through LabVIEW or C-APIs. Do you make all the above requirements possible with your library
and API support?

Answer: Our API provide an interface to group more Simulyzers into a so called SimulyzerSystem. This system could be
configured with one API call and a configuration file where the Simulyzer's of the system are defined.

One additional API call is needed to provide the simulation data to system. That's all. After receiving the external trigger
signal the simulation data is streamed on the PSI5 interface.



'ad Vd 9

HiL-Setup with PSI5, SPI and SQUIB

SESKION

2. Detailed view on HilL-System

Real-time system:
Provides data communication and residual bus simulation of a real operation and synchronizes the simulation system by a
trigger pulse.

PSI5 Simulyzer:

Peripheral acceleration or pressure sensor signals are simulated by PSI5-Simulyzer boxes. A maximum of 6 sensors can be
measured per Simulyzer. Mixed operation with real sensors is possible. Each sensor to be simulated and its signals must be
described according to the real-time system.

SPI Simulyzer:

The internal acceleration sensors are simulated by SPI Simulyzer boxes. The number of boxes to be used depends on the
number of sensors and the interfaces used. Mixed operation with real sensors is possible. Each sensor to be simulated in
the system and its signals must be described according to the real-time system.

Triggering ECU:
Provides the ignition pulse.

PC system:
Data technical environment for sequence control and archiving/analysis of the measurement data.

2.1 Data preparation

The usual PSI5/SPI Simulyzer data export functions can be used to analyze/archive the data.

The generation of errors on protocol level is possible and must be either already included in the provided streaming data or
in the provided ppf/spf files must have already been created or defined.
A detailed description can be found in the respective help system of the Simulyzer software.

The detection of the airbag deployment by the SQUIB box is possible (SQUIB replacement).
Special solutions can be realized in consultation with Seskion GmbH - e.g. feeding of position data from GPS sensor or
similar.

Other sensor protocols like SENT or DSI3 are also supported.

2.2 Structure of the system - simulation data by means of binary array

The following example system is used for description:

1x PSI5-Simulyzer-Box
Serial No.: 2283

Channel 0 used
Channel 1 not used

1. Signal sends in slot 0

Initdata:

Phase 2: 42010714A480DF11790017C17037308C
Phase 3: Ox1e7:16 0x0

Real-time data signal trace:“PSI5_I0_Slot0 Index 1"

2. Signal sends in slot 1

Initdata:

Phase 2: 42010714A480DF11790017C17037308D
Phase 3: Ox1e7:16 0x0

Real-time data signal trace: “PSI5_I0_Slot1 Index 1"

1x SPI-Simulyzer-Box
Serial No.: 162

Channel 0 used
Channel 1 not used

1. Sensor signal

Signal name AccX

Start of data transmission with falling edge
Real-time data signal trace:“AccX Index 10"

2. Sensor signal
Signal name AccY
Real-time data signal trace:“AccY Index 11"

3. Sensor signal
Signal name AccX_1
Real-time data signal trace:“AccX_1 Index 12"
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2.2.1. System configuration file for binary array
The system configuration file is a mandatory file in *.xml format for configuring the HIL system with reference to:

- Simulyzer license verification

- SPIsensor information via spf-file reference (SPI configuration data generated from SPI-Simulyzer software)
- SPI signal name definition according to simulation data.

- PSI5 sensor information via ppf-file (PSI5 configuration data generated from PSI5-Simulyzer software).

- PSI5 signal name definition according to the simulation data.

Example (SimulyzerSystemConfigurationFile.xml):

<?xml version="1.0" encoding="UTF-8"2> Location of the Seskion license file
- <SimulyzerSystemConfigurationFile>
hseionty

<BasePath>./</BasePath>
<LicenseFile>../seskionLicense.xml</LicenseFile>
- <Simulyzer> L. X
<Type>SPI</Type> Definition of the SPI sensor signals
<SerialNumber>162</SerialNumber>
<StreamStartPin Polarity="activeLow">1</StreamStartPin>
<ConfigurationFile>../configs/SPI/Example_Simulation_SPI_Sensor.spf</ConfigurationFile>
- «<Sensor>
«<!-- StreamDataIndex index of data array provided by api call SimulyzerSystemSetSignalData for sensor simulation-->
<!-- first index is for first Hawthorn chip channel 1 -->
<StreamDatalndex sigNhame="AccX">10</StreamDatalndex>
<!-- second index is for first Hawthorn chip channel 2 -->
<StreamDatalndex sigName="AccY">11</StreamDatalndex>
< !-- third index is for second Hawthorn chip channel 1 -->
<StreamDatalndex sigNhame="AccX_1">12</StreamDatalndex>
</Sensor>
</Simulyzer>
- <Simulyzer> Definition of the PSI5 sensor signals 1
<Type>PSI5</Type>
<SerialNumber>2283</SerialNumber>
<ConfigurationFile>../configs/PSI5/Example_Simulation_PSI5_Sensor.ppf</ConfigurationFile>
- <Sensor>
<!-- InterfaceIndex = defines the physical PSI5 interface on Simulyzer Box Value 0/1 -->
<InterfaceIndex>0</Interfacelndex>
<!-- SlotIndex 0/1/2/3 defines the timeslot on PSIS bus-->
<SlotIndex>0</SlotIndex>
<!-- InitPhase2Data string of hex encoded data nibbles for sensor initialization, start with first data nybble on left side-->
<InitPhase2Data>42010714A480DF11790017C17037308C</InitPhase2Data>
<!-- InitPhase3Data list of hex encoded data for init phase 3, :n behind value defines a repetion count of this value-->
<InitPhase3Data>0x1e7:16 0x0</InitPhase3Data>
<!-- StreamDatalndex index of data array provided by api call SimulyzerSystemSetSignalData for sensor simulation-->
<StreamDatalndex sigName="PSI5_I0_Slot0">2</StreamDatalndex:>
</Sensor>
- <Sensor>
SIMTIEsIe - O] IR Definition of the PSI5 sensor signals 2
<SlotIndex>1</SlotIndex>
<InitPhase2Data>42010714A480DF11790017C17037308D</InitPhase2Data>
<InitPhase3Data> 0x1e7:16 0x0 </InitPhase3Data>
<StreamDatalndex sigName="PSI5_I0_Slotl">1</StreamDatalndex:>
</Sensor>
</Simulyzer>
</SimulyzerSystemConfigurationFile>
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Definition of the SPI Sensors

For each SPI-Simulyzer box a definition must be made according to the following scheme, it does not matter if more than
the sensor signals defined here are present in the real-time data or not. All undefined signals are ignored.

In the example only one SPI-Simulyzer box is used, therefore only one SPI definition block starting and ending with

<Simulyzer> is defined. There must be a definition block for each Simulyzer box used.

Sensor type

Serial number of the Simulyzer Box

<Simulyzer>

<Type>SPI</Type> Streamstart definition

<SerialNumber>162</SerialNumber>
<StreamStartPin Polarity="activeLow">1</StreamStartPin>

Location/Name of spf-file

<ConfigurationFile>../configs/SPI/Example_Simulation_SPI_Sensor.spf</ConfigurationFile>

- <Sensor>
<!-- StreamDatalndex index of data array provided by api call SimulyzerSystemSetSignalData for
<!-- first index is for first Hawthorn chip channel 1 -->
<StreamDatalndex sigName="AccX">10</StreamDatalndex>
<!-- second index is for first Hawthorn chip channel 2 -->
<StreamDatalndex sigName="AccY">11</StreamDatalndex>
<!-- third index is for second Hawthorn chip channel 1 —->
<StreamDatalndex sigName="AccX_1">12</StreamDatalndex>
</Sensor>

</Simulyzer>

Sensor type: Type of sensor

Serial number of the SPI-Simulyzer box

sensor simulation-->

1. Signal of Sensor “[Name]” >Signallspur<
2. Signal of Sensor “[Name]” >Signallspur<

3. Signal of Sensor “[Name]” >Signallspur<

StreamstartPinPolarity-Definition: Definition of the start pulse for data transmission used by the Simulyzer box as master
for all connected Simulyzer boxes. In the example, a pulse is sent to all Simulyzer boxes at pin 1 and data transmission is

started with its falling edge.

If this streamstart pulse comes from the system or automatically, no definition is required.

Path/filename of the spf-file - configuration file generated from the SPI-Simulyzer software. (see SPI-Simulyzer webhelp)

Generation of a spf-file from the Simulyzer

Dateiname: [

software: Menu File - Command Save as...

~ Ordner ausblenden

Dateityp: | SPI Simulyzer Project files@

Signal definition
One SPI-Simulyzer box can simulate a maximum of 4 SPI sensors.
These 4 SPI sensors can be distributed on one or both interfaces.

ECU |cs14 12] a8 SPI-Simulyzer
o8 [MISO Real 1.1 :
S0
sl
SCLK
Sensort
- |cso 10|
Pwisoreaiof 24f 50
s e D Dios
o ey 5 Mos|
;
{ b cK 5
50K Jmisouc.t 6, Eu;o Interface 1
Sensor2 il

The signal definition must be done according to the data of the binary array.
Each signal trace is defined by the unique defined signal name in the binary array and the corresponding stream index of

the binary array.

Example Wiring
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Definition of the PSI5 sensors

For each PSI5 sensor signal a definition must be made according to the following scheme. It does not matter whether more
than the sensor signals defined here are present in the real-time data or not.
All undefined signals are ignored.

In the example only one PSI5-Simulyzer box is used, therefore only one PSI5 definition block starting and ending with
<Simulyzer> is defined. There must be one definition block for each Simulyzer box used.

(For example data see “2.2.1. System configuration” page 4).

Sensor type

Serial number of the Simulyzer Box

- <Simulyzer>

Signal Slot 0

< TypesPSIS</Type> Location/Name of ppf-file
<SerialNumber>2283</SerialNumber>
<StreamStartPin Polarity="activeLow">1</StreamStartPin>
<ConfigurationFile>../configs/PSI5/Example_Simulation_PSI5_Sensor.ppf</ConfigurationFile>
- <Sensor>
<!-- Interfa e physical PSIS interface on Simulyzer E Value 0/1 --> .
<lnterface[ndex>0</Interfacelndex> Interface of the Slgnal
<!-- SlotIndex 0/ jefines the timeslot on PSIS5 bus--> . .
<S|ot1ndex>0</slotlndex> Slotindex of the S|gna|
<!-- InitPhase2Data string of hex encoded data nibbles for sensor initialization, start with first data nybble on left side-->
<lnIZP'hase%Data>42‘?197’14;A}?‘800‘F1117900l7Cl7VC‘I’37?08C</!‘n|tP??592Data> = = ‘ e =g Data ofthe S|gna| |n |n|tphase2
<ln|tPhase3Data>0xle7 16 ox0</ln|tPhaseBData> H NN
ekt ¢ brovided by api call SimulyzerSystemBatSignalbata for sensor amuiaion— _ Data Of the signal in initphase3
<StreamDataIndex sighame=" PSIS lo Slolo >2< StreamDataIndex> .
L 2t ? 5 1. Signal of the Sensor “[Name]”
<Sensor>
<InterfaceIndex>0</Interfacelndex>
<SlotIndex>1</SlotIndex>
<InitPhase2Data>42010714A480DF11790017C17037308D </InitPhase2Data>
<InitPhase3Data> Ox1e7:16 0x0 </InitPhase3Data>
<StreamDatalndex sigName="PSI5_I0_Slot1">1</StreamDatalndex>
L </sensor>

Signal Slot 1

</Simulyzer>
</SimulyzerSystemConfigurationFile>

Sensor type: Type of sensor

Serial number of the PSI5-Simulyzer box

Path/filename of the ppf-file - which can be generated from the Simulyzer software and describes the PSI5 sensor
(see PSI5-Simulyzer webhelp)

Generation of a ppf-file from the Simulyzer software: B v
Menu File - Command Save as... Dateityp: ps,SS;mulyze,p,ojedme@ >
A Ordner ausblenden Abbrechen

Interface: Channel on which the PSI5 sensor signal sends (Channel 0 or 1).
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Slot index: Slot index in which the PSI5 sensor sends its data.
The assignment of the time slot in which the data signal is transmitted in the PSI5 real-time system must be entered
accordingly.

SensorSignal-Sammlungs-Editor ? .
PSI5-Simulyzer-Software
H H : H Member: PS15_I0_Slot0-Eigenschafts . . .
Signal 1 used in simulation oy en Signal-Collection-Editor
Signal 2 used in simulation 1| PSI5_10_Siot! L
A - . . 2| PSI5_I0_Slot2 + Display
Signal 3 not used in simulation gt
v s
v Descriptor
DataRegion DataRegionA
DataWicth 10
FirstBtOfFreeDefined 0
FrameControl 0
IgnoreEmor False
e e | 1stsignal comes from
SerialFormat 16B2Data  False B H
ey o / Sensor 0 in timeslot 0
Slotindex 0
SlowChannel False
Sonstiges
Trigger
.
Hotrechen
SensorSignal-Sammiungs-Editor ? X
Member: PSI5_I0_Slot1-Eigenschaften:
l;.' PSI5_I0_Slotd + 2 ;\H
2| PSI5_I0_Slot2 3 Display
Plot
v Slots
v Descriptor
DataRegion DataRegionA
DataWidth 10
FirstBtOfFreeDefined 0
FrameControl 0
IgnoreEmor False
FrameCortrol  False .
s 1< 2nd signal comes from
SerialFormat 168¢Data  False . .
SadiD 0 / Sensor 1 in timeslot 0
Slotindex 0
i i H SlowChannel False
According to this assignment, the o
. . S
definition must be made in the -
configuration file.

Initphase 2/3: Hexadecimal data sent by the sensor during the initialization phase.
The data can be copied and pasted in the PSI5 software via the Init Data Report.

[ InitDataReport

File CopylnitData

Overview

Datats | | o001 1| o001 1 |
Datats | [ o001 1 0001 1 [ ki
Datal? | 0111 7 om | 7 [

Datats | 1001 9 | 1001 9 [

Data19 [“oo00 [0 [ o000 [ 0 [

Data20 0000 0 0000 0 |

Data21 [ o001 1 0001 1 [

Data22 | [ o 7 0111 7 [

[Datazs | [0 [ ¢ [ 1100 [ ¢ [

Data24 | [ o001 1 0001 | 1 [

Data2s | [ om 7 ot | 7 [

Data26 | 0000 0 0000 0 [

Data27 [ o011 3 o011 | 3 [

Data28 0111 7 [ o 7 [

Data29 | [ oom 3 | oot 3 [

Data30 | [0 [0 [ o0 [ 0 [

Data31 | [ 1000 8 1000 8 [

Data32 | [ 1100 [ 1101 D

Hexadecimal values of the init data

o BPh2 42010714A480DF11790017C17037308C / for Slot1 and Slot2
i [0x20F 0x21C 0x20F 0x21C 0x20F 0x21C 0x1E7 0x1E7 0x1E7 Ox1E7 0x1E7

1aitPh3 017 0x1E7 0x1E7 Ox1E7 Ox1E7 Ox1E7 OxIE Ox1E7 OxIE Ox1E7 OxIE7
i | PPA2[42010714A450DF 1179001 7C17037308D For transfer with copy/paste
2

TnieP! . [0x20F 0x21D 0x20F 0x21D 0x20F 0x21D 0x1E7 0x1E7 Ox1E7 0x1E7 Ox1E7
|0x1E7 0x1E7 0x1E7 0x1E7 0x1E7 0x1E7 0x1E7 Ox1E7 0x1E7 Ox1E7 Ox1E7

Stot | litPh2
3 | |nitPh3

Streamdataindex(signal data definition)
according to the number of signals and the signal names defined in the binary data array.
Each signal track is identified by

- the unique defined signal name and a
- 1-digit signal index of the defined binary data array.
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2.2.2. PPF file

The ppf file contains all characteristic PSI5 bus data (type, timeslot definition, data length, data count and many more).

The file can be generated by the PSI5-Simulyzer software.

There must be one file per PSI5-Simulyzer box used.

Example of a ppf file:

<?xml version="1.0" encoding="utf-8"?>
<PSI5SimulyzerProjectFile>
<Version>1.0</Version>
<Culturelnfo>de-DE</Culturelnfo>
<SensorDataVersion>2</SensorDataVersion>
<Template>False</Template>
<ApplicationSettings>
<CommonTriggerConfig>
<RefSigTrigger0>0</RefSigTrigger0>
<RefSigTrigger1>0</RefSigTrigger1>
<RefSigTrigger2>0</RefSigTrigger2>
<RefSigTrigger3>0</RefSigTrigger3>
<Mask>5</Mask>
</CommonTriggerConfig>
<UseModel>2</UseModel>
<ImportedDataMode>0</ImportedDataMode>
<StreamStartMode>2</StreamStartMode>

< eplay%untﬂﬁSWnﬁ
>100</ TR

Generation of a ppf-file from the Simulyzer software:
Menu File - Command Save as...

2.2.3. SPF file

Dateiname: |

Dateityp: | PSI5 Simulyzer Project file (*.ppf)

A Ordner ausblenden

ern

Abbrechen

The spf file contains all characteristic PSI5 bus data (baud rate, CS allocation, data count and many more).

The file can be generated by the PSI5-Simulyzer software.

There must be one file for each SPI-Simulyzer box used.

Example of an spf file:

k2xml version="1.0" encoding="utf-8"?>
<SPISimulyzerProjectFile>
<Version>1.1</\VVersion>
<Cultureinfo>de-DE</Cultureinfo>
<SensorDataVersion>2</SensorDataVersion>
<Template>False</Template>
<CanConfig>
<rxonbx=0</rxontx=
<btr0>=15</btr0>
<btr1=0</btr1>

<cdr>128</cdr>
W

Generation of a spf-file from the Simulyzer software:
Menu File - Command Save as...

Dateiname:

Dateityp: | SPI Simulyzer Project fil@

~ Ordner ausblenden

__Speichem

Abbrechen
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2.2.4. Program for process flow control

The program controls the entire HIL test system and regulates the complete measurement process.

Possible programming languages: API: ANSI-C, Python, dotNET
Knowledge of the corresponding programming language is assumed.
In principle, the API contains the following structure (example Python)

1. definition of the binary array

#provide twenty(20) buffers with downsampled data

bufferCount = 20

sampleCnt = (c_int * bufferCount)() #hold the valid count of sample buffer
sampleBuffers = (c_void_p * bufferCount)() #array to store the buffer adresses

for n in range(0,bufferCount):
sampleCnt[n] = 300; #set sample count
buff = (c_double * 3000)()
for k in range(0,2899):
bufflkl=(n+1)*10
sampleBuffers[n] = cast(pointer(buff),c_void_p) #store buffer address
bufffsampleCnt[n}- 1]1=0 #set stream data back to zero

2. loading the Simulyzer driver

#load the simulyzer library
os.chdir(".Atmp™)

hnd = cdll.LoadLibrary(”../Simulyzer.dil")
print hnd

3. generate the measuring system and link it to the system confiquration.xml|

#create a system handle from system configuration file
syshnd = c_void_p()

sekRetVal = hnd.StartLogging("simu.log”,c_int(LoggingWhat[ TRACE_APICALLST+LoggingWhat[TRACE_ERRORT),c_int(LoggingHow[MODE_REOPENT+LoggingHow[MODE_CONSOLE_OUTT))
print "StartLogging return code: " + str(sekRetVal)

sekRetVal = hnd.SimulyzerSystemCreate(byref(syshnd),”../ExampleSystemConfig.xmI")
print “SimulyzerSystemCreate return code: * + str(sekRetVal)

#read back the actual count of initialized simulyzer devices (only for testing)

devCount = c_int(10)

devHnd = (c_void_p * 10)()

hnd.SimulyzerSystemGetDevices(syshnd, byref(devCount),pointer(devHnd))

print devCount

sekRetVal = hnd.SimulyzerSystemSetStreamEndCallback(syshnd, callback_ctx,cb_func)
print "SimulyzerSystemSetStreamEndCallback return code: ™ + str(sekRetVal)

4. login - check of proper system setup and readiness of individual components.

5. start command of the measuring system/start of the trigger pulse

6. stop of the measuring system - stop command

#set the data for streaming

hnd.SimulyzerSystemSetSignalData(syshnd, bufferCount,pointer(sampleCnt), pointer(sampleBuffers),1)
#set trigger signal

raw_input("return to continue®)

rdy_flag.clear()

hnd.SimulyzerSystemStartStream(syshnd)

rdy_flag.wait(2.0)

print rdy_flag.isSet()

The individual extension is up to the user and can be carried out without restriction in view of the system processes can be
carried out.
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Example complete API (Python)

[from ctypes import *

import os

from SimulyzerConstants import *
import threading

rdy_flag = threading.Event()

def py_callcack(v_p):
print "Stream complete™
rdy_flag.set()
return

CMPFUNC = WINFUNCTYPE(None,c_void_p)
cb_func = CMPFUNC{py_calicack)
callback_ctx = c_void_p()

#provide twenty(20) buffers with downsampled data

bufferCount = 20

sampleCnt = (c_int * bufferCount)() #hold the valid count of sample buffer
sampleBuffers = (c_void_p * bufferCount)() #array to store the buffer adresses

for n in range(0,bufferCount):
sampleCnt[n] = 300; #set sample count
buff = (c_double * 3000)()
for k in range(0,2999):
bufflk] = (n + 1) * 10
sampleBuffers[n] = cast(pointer(buff),c_void_p) #store buffer address
buffisampleCnt[n] - 1] = 0 #set stream data back to zero

#load the simulyzer library
os.chdir("./tmp”)

hnd = cdll.LoadLibrary("../Simulyzer.dil")
print hnd

#create a system handle from system configuration file
syshnd = c_void_p()

sekRetVal = hnd.StartLogging("simu.log™,c_int(LoggingWhat[ TRACE_APICALLST+LoggingWhat[TRACE_ERRORT),c_int(LoggingHow['MODE_REOPENT+LoggingHow[MODE_CONSOLE_OUTT))

print “StartLogging return code: " + str(sekRetVal)

sekRetVal = hnd.SimulyzerSystemCreate(byref(syshnd),”. /ExampleSystemCon fig.xml")
print "SimulyzerSystemCreate return code: * + str(sekRetVal)

#read back the actual count of initialized simulyzer devices (only for testing)

devCount = c_int(10)

devHnd = (c_void_p * 10)()

hnd.SimulyzerSystemGetDevices(syshnd, byref(devCount),pointer(devHnd)})

print devCount

sekRetVal = hnd.SimulyzerSystemSetSti EndCallback(syshnd,callback_ctx,cb_func)
print “SimulyzerSystemSetStreamEndCallback return code: * + str(sekRetVal)

#set the data for streaming
hnd.SimulyzerSystemSetSignalData(syshnd,bufferCount,pointer(sampleCnt),pointer(sampleBuffers),1)
#set trigger signal

raw_input("return to continue®)

rdy_flag.clear()

hnd.SimulyzerSystemStartStream(syshnd)

rdy_flag.wait(2.0)

print rdy_flag.isSet()

#cleanup all simulyzer stuff
hnd.SimulyzerSystemDestroy(syshnd)

10
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2.3. Structure of the system - simulation data via CSV file

The following example system is used for description:

1x PSI5-Simulyzer-Box
Serial No.: 2283

Channel 0 used
Channel 1 not used

1. Signal sends in slot 0

Initdaten:

Phase 2: 42010714A480DF11790017C17037308C
Phase 3: 0x1e7:16 0x0

Real-time data signal trace:“PSI5_10_Slot0 Index 1"

2. Signal sends in slot 1

Initdaten:

Phase 2: 42010714A480DF11790017C17037308D
Phase 3: Ox1e7:16 0x0

Real-time data signal trace: “PSI5_I0_Slot1 Index 1"

1x SPI-Simulyzer-Box
Serial No.: 162

Channel 0 used
Channel 1 not used

1. Sensor signal

Signal name AccX

Start of data transmission with falling edge
Real-time data signal trace:“AccX Index 10"

2. Sensor signal
Signal name AccY
Real-time data signal trace:“AccY Index 11"

3. Sensor signal
Signal name AccX_1
Real-time data signal trace:“AccX_1 Index 12"

2.3.1. System configuration file for CSV data

Mandatory file in *xml format to configure the HIL test system regarding:

- Simulyzer license verification
- Decoder file reference SPI signals for data preparation

- SPI sensor information via spf-file reference (SPI configuration data generated from SPI-Simulyzer software)

- SPIsignal name definition according to simulation data.
- Reference to - PSI5 bus *csv file

- PSI5 sensor information via ppf-file (PSI5 configuration data generated from PSI5-Simulyzer software)

- Decoder file reference PSI5 signals for data preparation

- PSI5 sensor information via ppf-file (PSI5 configuration data generated from PSI5-Simulyzer software)

- PSI5 signal name definition according to simulation data.

<?xml version="1.0" encoding="UTF-8"?>

Location of the Seskion license file

- <SimulyzerSystemConfigurationFile>
clzsize

<BasePath>./</BasePath>
<LicenseFile>../seskionLicense.xml</LicenseFile> 1

- <Simulyzer>

SPype-SPLs/Types ; Definition of PSI5-Sensor
<SerialNumber>4711</SerialNumber>
<CSV_DecoderFile>../ figs/SPI/ | ion_SPI_CSV_Description.xml</CSV_DecoderFile>
<ConfigurationFile>../: figs/SP1/! ion_SPI_Sensor.spf</ConfigurationFile>
- <Sensor>

=t ndex is rm chif
<StreamDatalndex sigName="AccX_1">12</Stream
</Sensor>
</Simulyzer>

- <Simulyzer>
<Type>PSI5</Type>
<SerialNumber=>2283</SerialNumber>
<StreamStartPin Polarity="activeLow">1</StreamStartPin>
<CSV_DecoderFile>../ figs/PSI5/ i i
<CSV_DecoderFile>../ figs/PSI5/!
<ConfigurationFile>../! gs/PSI5/

- <Sensor>
<!-- InterfaceIndex = defines the physical PSIS5 ir
<InterfaceIndex>0</InterfaceIndex>
Bl x 0/1/2/3 he timeslot o
<SlotIndex>0</SlotIndex>
i ThitE

Definition of PSI5-Sensor signal 1

_PSI5_0_0_CSV_Description.xml</CSV_DecoderFile>
_PSI5_0_1_CSV_Description.xml</CSV_DecoderFile>
ion_PSI5_Sensor.ppf</ConfigurationFile>

nterface on Simulyzer Box Value 0/1 -->

ex
<StreamDatalndex sigName="PSI.
</Sensor>

- <Sensor>
<Interfacelndex>0</InterfaceIndex>
<SlotIndex>1</SlotIndex>
<InitPhase2Data>42010714A480DF11790017C17037308D</InitPhase2Data>
<InitPhase3Data> O0x1e7:16 0x0 </InitPhase3Data>
<StreamDatalndex sigName="PSI5_I0_Slot1">1</StreamDatalndex:
</Sensor>

Definition of PSI5-Sensor signal 2

</Simulyzer>
</SimulyzerSystemConfigurationFile>
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Definition of the SPI sensors

For each SPI sensor signal a definition must be made according to the following scheme. It does not matter whether more
than the sensor signals defined here are present in the simulation data or not.

All undefined signals are ignored.

In the example only one SPI-Simulyzer box is used, therefore only one SPI definition block starting and ending with
<Simulyzer> is defined. There must be a definition block for each Simulyzer box used.

Sensor type
Vo Serial number of the Simulyzer Box
<Simulyzer>
<Type>SPI</Type>
<SerialNumber>4711</SerialNumber>
<CSV_DecoderFile>../configs/SPI/Example_Simulation_SPI_CSV_Description.xml</CSV_DecoderFile>
<ConfigurationFile>../configs/SPI/Example_Simulation_SPI_Sensor.spf</ConfigurationFile> Location/Name Of spf—file

Location/Name of SPI-Decoder file

- <Sensor>
<!-- StreamDatalndex index of data array provided by ap!
< !-- first index is for first

<StreamDatalndex sigName
<l 1d index for fir
<StreamDatalndex sigName

3l Simulyz SystemS '77,‘<>"|"(‘\ er r 3t -
awthorn chip channel 1 => 1. Signal of Sensor “[Name]”
AccX">10</StreamDatalndex> . " ,

t Hawthorn chip channel 2 --> 2, Signal of Sensor “[Name]
AccY">11</StreamDatalndex>

<!=- third index is for second Hawthorn chip channel 1 —-> 3, Signal of Sensor “[Name]”
<StreamDatalndex sigName="AccX_1">12</StreamDatalndex>
</Sensor>

</Simulyzer>

Sensor type: Type of sensor

Serial number of the SPI-Simulyzer box.

Path/filename SPI decoder csv file

Path/filename of the spf-file - Configuration file generated from the SPI-Simulyzer software. (see SPI-Simulyzer webhelp).

Creation of an spf-file from the Simulyzer software: . -
Menu File - Command Save as... Dateityp: | 5Pl SimulyzerProjectfile@ °
A Ordner ausblenden Abbrechen

Signal definition

according to the number of signals of the SPI sensor and the signal names defined in the real-time data.csv.
Each signal track is identified by

- the unique, defined signal name and a

- 2-digit signal index.
l.index = channel 0 or 1 (interface 1 or 2)
2.Index = Chipselect line of the signal.

12
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SPI Decoderfile

The SPI Decoderfile references and defines the SPI signals from the simulation data file.

Per data value

Per data value

Separator

<?xml version="1.0" encoding="UTF-8"?>
<ImportDescriptionFile>

<Separator>,</Separatet> Line of Slgnal names

<MapDefinitionLine>1</MapDefinitionLine>
<FirstDataLine>2</FirstDatalLine> R .
= < Column> ————————Start line of signal data

<!-- ASG51 Channel 1(Interface 0) 16LSB/g 9.81 m/s*s = 1g 16LSB/(9.81 m/s*s) 1.63LSB/(m/s*s)-->

SR 1 BTSN Scaling factor of the data value

<Name>ACCX</Name> s T ] .
<Format>double</Format> Signal designation

</Column> T Number format of the data value
<Column>
<!-- ASG51 Channel 1(Interface 0) 16LSB/g 9.81 m/s*s = 1g 16LSB/(9.81 m/s*s) 1.63LSB/(m/s*s)-->
<Scale>1.63</Scale>
<Name>ACCY</Name>
<Format>double</Format>
</Column>
<!-- AccX --> Number of bits of the data value
<DataStream>,
<Size>32</Size>

</DataStream>
== AccY —>
<DataStream>
<Size>32</Size>
<RefColumn Align="0" Pos="0" Width="16">ACCY </RefColumn>
</DataStream>
<!-- AccX_1 -->
<DataStream>
<Size>32</Size>
<RefColumn Align="0" Pos="0" Width="16">ACCX</RefColumn>
</DataStream>
<RequiredColumnCount>2</RequiredColumnCount>
</ImportDescriptionFile>

\ Number of data value columns

Definition of the PSI5 sensors

For each PSI5 sensor signal, a definition must be made according to the following scheme.
(Example data see “2.3 System configuration file for CSV data” page 11)

PSI5 Sensor 0

PSI5 Sensor 1

<Simulyzer>

T PSI5</T . .
:Sz'r)iZI)Numb:»;;§;</Seriamumber> / Path Decoderfile PSI5-S|gna| Channel 0 Slot 1

Sensor type
/ /— Serial number of Simulyzer box Path Decoderfile PSI5-Signal Channel 0 Slot 0

<StreamStartPin Polarity="activeLow">1</StreamStartPin>
<CSV_DecoderFile>../: figs/PSIS5/! _Simulation_PSI5_0_0 V_Description.xml</CSV_DecoderFile>
<CSV_DecoderFile>../ configs/PS15/ ple_Simulation_PSI5_0_1_CSV_Description.xml</CSV_DecoderFile> Path/f”ename of the ppf file
<ConfigurationFile>../ figs/PSI5/! Y ion_PSIS5_ .ppf</ConfigurationFile

- <Sensor> .

<!-- Interfacelndex = defines the physical PSI5 interface on Simulyzer Box Value 0/1 --> Interface (Channel) Slgha|5

<InterfaceIndex>0</Interfacelndex>

<!-- Slotindex 0/1/2/3 defines the timeslot on PSI5 bus--> Slot index of the signal

<SlotIindex>0</SlotIndex>
<!-- InitPhase2Data string of hex encoded data nibbles for sensor initialization, start with first data nybble on left side-->

<InitPhase2Data>42010714A480DF11790017C17037308C</InitPhase2Data> Data Of the Signal in the init phasez
<!-- InitPhase3Data list of hex encoded data for init phase 3, :n behind value defines a repetion count of this value-->

<InitPhase3Data>0x1e7:16 0x0</InitPhase3Data> Data of the signal in the init phaseg
<!-- StreamDatalndex index of data array provided by api call SimulyzerSystemSetSignalData for sensor simulation-->

<StreamDatalndex sigName="PSI5_I0_Slot0">2</StreamDatalndex> 1.Signa| Of the sensor ”[Name]"

—— </Sensor>
- <Sensor> .
<InterfaceIndex>0</InterfaceIndex> Interface (Channel) Slgna|5

<SlotIindex>1</SlotIndex>
<InitPhase2Data>42010714A480DF11790017C17037308D </InitPhase2Data> 4\ Slot indeX of the Signal

<InitPhase3Data> 0x1e7:16 0x0 </InitPhase3Data>
<StreamDatalndex sigName="PSI5_I0_Slot1">1</StreamDatalndex>

L </sensor> Data of the signal in the init phase2

) Data of the signal in the init phase3
1.signal of the sensor “[Name]”

13
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Sensor type: Type of sensor

Serial number of the PSI5-Simulyzer box.

StreamstartPinPolarity-Definition: Definition of the start pulse for data transmission which is used by the Simulyzer box as
master for all connected Simulyzer boxes. In the example, a pulse is sent to all Simulyzer boxes at pin 1 and data

transmission is started with its falling edge.

If this stream start pulse comes from the system or automatically, no definition is required.

Path/filename of the ppf-file which can be generated from the Simulyzer software and which describes the PSI5 sensor.

(see PSI5-Simulyzer webhelp)

Creation of a ppf-file from the Simulyzer-
Software: Menu File - Command Save as...

Dateiname: | |

Dateityp: | PSIS Simulyzer Project filed (*.ppf) X

Ordner ausblenden

Abbrechen

Interface: Channel on which the PSI5 sensor signal is sent (channel 0 or 1).

Slot index: Slot index in which the PSI5 sensor signal is sent. The assignment of the time slot in which the data signal is sent
is done in the PSI5 simulation system and must be entered accordingly.

SensorSignal-Sammlungs-Editor

PSI5-Simulyzer-Software

. L . Member PSI5_10_Slot0-Eigenschaften . . .
Signal 1 used in simulation s S 5 Wy Signal-Collection-Editor
Signal 2 used in simulation 1] PSI5_10_Siot1 __L

. . . . 2] PSI5_10_Slo2 3+ Display
Signal 3 not used in simulation ::
v s
v Descriptor
DataRegion DataRegionA
DataWidth 10
FirstBtOffreeDefined 0
FrameControl 0
IgnoreEmor False
[ FrameControl Fal: .
e a8 1st signal comes from
SerialFormat 1662Data  False H H
SerallD 0 / Sensor 0 in timeslot 0
Slotindex 0
SlowChannel False
Sonstiges
e — =
Hinzufugen Entfemen
Retrechen
SensorSignal-Sammiungs-Editor ? X
Member: PSI5_|0_Slot 1-Bigenschaften:
0] PSI5_I0_Slot0 7 !
il PSI5_i0_Siot1 -k
2| PSI5_I0_Slot2 + Display
Plot
v Slots
v Descrptor
DataRegion DataRegionA
DataWidth 10
FirstBtOffreeDefined 0
FrameControl 0
ignoreEmor False
FrameControl False .
et 1 «— 2ndsignal comes from
SeralFormat 168¢Data  False H :
mwy o / Sensor 1 in timeslot 0
Slotindex 0
H H H SlowChannel False
According to this assignment, the o
L . T
definition must be made in the - o
configuration file.
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Initphase 2/3: Hexadecimal data sent by the sensor during the initialization phase.
The data can be copied and pasted in the PSI5 software via the Init Data Report.

{¥ mitDataReport

File CopylnitData
Overview
Datats |
patats | 0001
|Datat7 | 0111
[Datats | 1001
patats | 0000

0001 0001
0001
0111
1001

0000

Data20 | 0000 0000
[Data21 | 0001 [ o001
[patazz | o111 [ om
[patazs | 1100 [ 100
[Data24 | 0001 0001
Datazs | o111 o111
Datazs | 0000 0000
Data27 | 0011 0011

0111
0011
0000
1000
1100

01
0011
[ 0000
[ 1000
1101

Data28 |
Data2s |
Dpataz0 |
Data3t |

Data32 |

o”ww}ﬂ_nﬂ_gwﬁ_a
of a/afu]<]ulal < <[] <] +]a]a] el <] <[

T

Hexadecimal values of the init data
S InitPh2 [42010714A480DF 1179001 7C17037308C / for Slot1 and Slot2
1 . 0x20F 0x21C 0x20F 0x21C 0x20F 0x21C 0x1E7 0x1E7 0x1E7 Ox1E7 Ox1E7 ‘

InitPh3 il
0x1E7 0x1E7 0x1E7 Ox1E7 0x1E7 Ox1E7 0x1E7 0x1E7 Ox1E7 0x1E7 Ox1E7
5 InitPh2 [42010714A480DF11790017C17037308D For transfer with copy/paste
o
2

WQEMOF 0x21D 0x20F 0x21D 0x20F 0x21D 0x1E7 0x1E7 0x1E7 0x1E7 Ox1E7 ‘/
|0x1E7 0x1E7 Ox1E7 0x1E7 0x1E7 Ox1E7 0x1E7 0x1E7 Ox1E7 0x1E7 0x1E7

Slot | TnitPh2
3 InitPh3

Streamdataindex(signal data definition)
according to the number of signals and the signal names defined in the CSV.
Each signal track is identified by

- the unique defined signal name and a
- 1-digit signal index

PSI5-Decoderfile
The PSI5 decoder file references and defines the PSI5 signals from the simulation data file.

Separator
<?xml version:"l./b" encoding="UTF-8"2>
- <ImportDescriptignFile> . .
<Separator>,</Separators Line of signal names
<MapDefinitionLine>1</MapDefinitionLine>

o] <FirstDataLine> 2 </FirstDatalLine>
3| - <Column> ~————————— Start line of signal data
S <Scale>1.63</Scale> Scaling factor of the data value
3 <Name>ACCY</Name> — . . .
3 <Format>double</Format> — Signal designation
o|  </Column> " Number format of the data value
o 7= <Column>
<Scale>1.63</Scale>
<Name>ACCX</Name>
<Format>double</Format>
9} </Column>
r—ju [ - <DataStream>
> <Size>32</Size>
% <RefColumn Align="0" Pos="0" Width="16">ACCX</RefColumn>
g P :gz:;g:::nm;/— Number of bits of the data value
o <Size>32</Size>
</DataStream>
- <DataStream>
<Size>32</Size>
<RefColumn Align="0" Pos="0" Width="16">ACCY</RefColumn>
</DataStream>

<RequiredColumnCount>3</RequiredColumnCount>

</ImportDescriptionFile> N
Number of data value columns
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2.3.2. PPF file

The ppf file contains all characteristic data (type, timeslot definition, data length, data count and many more).
The file can be generated by the PSI5-Simulyzer software.
There must be one file per PSI5-Simulyzer box used.

Example of a ppf file:

<?xml version="1.0" encoding="utf-8"7>
<PSI5SimulyzerProjectFile>
<Version>1.0</Version>
<Cultureinfo>de-DE</Cultureinfo>
<SensorDataVersion>2</SensorDataVersion>
<Template>False</Template>
<ApplicationSettings>
<CommonTriggerConfig>
<RefSigTrigger0>0</RefSigTrigger0>
<RefSigTrigger1>0</RefSigTrigger1>
<RefSigTrigger2>0</RefSigTrigger2>
<RefSigTrigger3>0</RefSigTrigger3>
<Mask>5</Mask>
</CommonTriggerConfig>
<UseModel>2</UseModel>
<ImportedDataMode>0</ImportedDataMode>
<StreamStartMode>2</StreamStartMode>
<StraamReplayCount>1</StreamReplavCount>
e 10025 Tk

Creating a ppf-file from the Simulyzer software: Dateiname: [[ 7
Menu File - Command Save as... Dateityp: | PSIS SimuiyzerProjectfiles@ v

Ordner ausblenden Abbrechen

2.3.3. SPF file

The spf file contains all characteristic PSI5 bus data (baud rate, CS allocation, data count and many more).
The file can be generated by the PSI5-Simulyzer software.
There must be one file per SPI-Simulyzer box used.

Example of spf file:
k?xml version="1.0" encoding="utf-8"?>
<SPISimulyzerProjectFile=
<Version>1.1</\ersion>
<Cultureinfo>de-DE</Cultureinfo>
<SensorDataVersion>2</SensorDataVersion>
<Template>False</Template>
<CanConfig»
<rxonbx>0</rxontx>
<btr0>15</btr0>
<btr1=0</btr1>

<cdr>128</cdr>
\W\

Creation of an spf-file from the Simulyzer ]
i Dateiname:
software: Menu File - Command Save as... Dateityp: | 591 Simu[yzerpmjmme@ =

A Ordner ausblenden Abbrechen
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2.3.4. Program for process flow control

The program controls the entire HIL test system and regulates the complete measurement process.

Possible programming languages: API: ANSI-C, Python, dotNET
Knowledge of the corresponding programming language is required.
In principle, the API contains the following structure (example Python)

vk wnN e

Generates the
measuring system

Stat of the measuring system
Start of the trigger pulse

loading of the Simulyzer driver

generation of the measuring system and linkage with the system configuration.xml
login - check of proper system configuration and readiness of individual components
start command of the measuring system/start of the trigger pulse

stop of the measuring system - stop command

Jrom ctypes import *

import oS

from SimulyzerConstants import *
import threading

rdy_flag = threading Event()

def py_calicack(v_p)
print “Stream complete”
rdy_flag set()
retumn

CMPFUNC = WINFUNCTYPE (None,c_void_p)
cb_func = CMPFUNC(py_calicack)
calback_ctx = ¢_void_p()

#load the simulyzer library

0s.chdir(".tmp") i i i
o 1L Loading the Simulyzer driver
print hnd

#create a system handle from system configuration file
syshnd = _void_p()

sekRetVal = hnd StartLogging("simu log",c_int(LoggingWhat{ TRACE_APICALLS'J+LoggingWhat[ TRACE_ERRORY) ¢_int(LoggingHow[MODE_REOPENJ+LoggingHow[MODE_CONSOLE_OUTY))
print “StartLogging retum code: * + str(sekRetVal)

sekRetVal = hnd . onfigcsvimportxmr) Path of the configuration file .xml
print “SimulyzerSystemCreate return code: * + str(sekRetVal)

#read back the actual count of initialized simulyzer devices (only for testing)

devCount = c_int(10)

devHnd = (c_void_p * 10)()

hnd SimulyzerSystemGetDevices(syshnd byref(devCount) pointer(devHind))

print devCount

sekRetVal = hnd Simulyzer d

print ™ allback retum code: * +

caliback_ctx,cb_func)

#set the data for streaming . . * .
hnd DataFromCSV(syshnd," /datalcrashi.csv",1) Path of the simulation data *.csv file

#set tngger signal

raw_input(‘return to continue”)

rdy_flag clear()

hnd SimulyzerSystemStartStream(syshnd)
rdy_flag wai(2.0)

print rdy_flag isSet()

#cleanup all simulyzer stuff
hnd SimulyzerSystemDestroy(syshnd)

The individual expansion is up to the user and can be carried out without restriction in view of the system processes.

Further sources of information and tutorials

Seskion GmbH
Karlsruher Strale

11/1

D-70771 Leinfelden-Echterdingen
Telefon: +49 (711) 990 58 14
Fax: +49 (711) 990 58 27

E-Mail: info@seskion.de
URL: http://www.seskion.de
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